CHOOSE SECURITY CLASSIFIC

4 Australian Government
Civil Aviation Safety Authority

Agenda Template

Chair:
Members:
Attendees:
Location:
Time:
ltems
item | Description | Person
Opening Meeting declared open Chair
e
2.
3
4.
5.
6.
T
8.
9. Other Business Chair
10. Next Meeting
11. Close Chair

Civil Aviation Safety Authority
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CHOOSE SECURITY CLASSIFICATION



CHOOSE SECURITY CLASSIFICATION

Actions
Action Description Responsible Date Due Status
Item Officer
114
2.

Civil Aviation Safety Authority
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CHOOSE SECURITY CLASSIFICATION



CHOOSE SECURITY CLASSIFIC

BRANCH OR DIVISION NAME

CASA Ref: [insert RMS number]

Title Name Surname
Position title [if required]
Address 1

Address 2 [if required]
SUBURB STATE Postcode

Dear Title Surname

CASA - Letterhead Template

Insert your letter here. Use the 'Normal’ style for text.

Yours faithfully/sincerely

Name Surname
CASA Position Title
00 Month YYYY

Civil Aviation Safety Authority
GPO Box 2005 Canberra ACT 2601 | Telephone: 131 757 10f1

CHOOSE SECURITY CLASSIFICATION



Meeting Minutes Template

CHOOSE SECURITY CLASSIFICA

Meeting:
Present:
Attendees:
Apologies:
Location:

Time:

Minutes

Item ’ Description

i Introduction

2. Agenda ltem 1 -

3. Agenda ltem 2 —

4. Agenda ltem 3 -
Actions

Action Description

Responsible Officer

Item

Date Due

Civil Aviation Safety Authority
Meeting Minutes Template | V1.0 | CASA-04-5548 | 10/2023
CHOOSE SECURITY CLASSIFICATION
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Australian Government

CHOOSE SECURITY CLASSIFICA

Civil Aviation Safety Authority

Minute Template

CASA Ref: RMS Reference i

Date: 17 December 2024 .
: To: '

Through ‘

CC: (Delete this line if not required) ‘
i From: ,
: Subject: Subject to be in bold type [
Purpose

(Insert the purpose of the minute)

APPROVED / NOT APPROVED / PLEASE DISCUSS

Name
Position title
Division

Civil Aviation Safety Authority

Minute Template | V1.1 | CASA-01-5549 | Month YYYY
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CHOOSE SECURITY CLASSIFI'
B Australian Government

Civil Aviation Safety Authority

Terms of Reference Template

Name: Name Surname
Date: Click or tap to enter a date.
Version: 1.0

Endorsement

Committee Members ‘ Date

Document Control

Description

Version No. ’ Date ’ Author

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 10f8
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CHOOSE SECURITY CLASSIFICATION

Distribution

Version No. ‘ Date ' Issued to

Related documents

Document Title ’ RMS8 Location

List of Acronyms

ToR Terms of Reference

DAS Director of Aviation Safety
DDAS Deputy Director of Safety
ADAS Associate Director of Safety

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 2 20of8
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CHOOSE SECURITY CLASSIFICATION

Table of Contents

Endorsement
Document Control
Distribution

Related Documents
List of Acronyms

1. Purpose and Objectives

2 Scope and Authority

3. Sources of XXXXXX Proposals

4. Membership and Roles

4.1 Composition

4.2  Chair

4.3 Secretariat

4.4  Other Attendees

5. Conduct of Meetings

5.1 Frequency

5.2 Venue

5.3 Scheduled Meetings
5.4 Unscheduled Meetings
5.5 Quorum

5.6 Decision Making

5.7 Standing Agenda ltems

6. Tracking and Reporting of Outcomes

6.1 Minutes
6.2 Action ltems
6.3  Projects/XXXXXX Proposal Register

T Management of Projects/XXXXX Proposals

8. Relationship to Other Committees or Key Stakeholders

9. Review
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Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY
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CHOOSE SECURITY CLASSIFICATION

1. Purpose and Objectives

The purpose of the NAME is to:
e review XXXX and establish XXXXX priorities based on identified XXXXXX and emerging XXXXX issues
e identify and define XXXXXX activities which may contribute to XXXXXX

e provide advice and recommendations to the XXXXX on the prioritisation and recommended level of
support of XXXXX proposals.

2. Scope and Authority

The role of the NAME is to:
e guide CASA's XXXXX priorities and propose resource allocation for approved XXXXX initiatives

o ensure that XXXXX is identified, monitored and coordinated across CASA and adheres to appropriate
XXXXX governance requirements

e maintain a register of current and proposed XXXXXX

e oversee the progress of ongoing XXXXX activities supported by CASA and provide progress reports to
the XXXXX

The NAME has no discrete budget, nor does the Chair or any member hold financial delegations that are
exercised on behalf of the Committee.

The Committee does not have the authority to approve expenditure. All funding/XXXXX proposals for
XXXXX that are supported by a recommendation from the NAME must be presented to the XXXXX for
funding/XXXXX.

The Committee provides advice and guidance on the merits and level of appropriate support recommended
for:

3. Sources of XXXXXX Proposals

Any CASA officer, including a member of the Committee, may submit a XXXXXX Proposal to the NAME.
Proposals must be endorsed by the proposing officer's Executive Manager, and submitted in electronic form
to the Committee Secretary.

4. Membership and Roles

4.1 Composition

The NAME will comprise the following members:
e XXXXX (Chair)

The above-named positions are permanent members of the Committee. Should 2 Committee member not be
available for a meeting an alternate management representative should be nominated to attend.

Permanent members and their alternates are the only attendees entitled to vote on matters under
consideration by the Committee.

Before attendance, alternate members are to be fully briefed by the respective member, including on any
voting matters.

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 40of8
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CHOOSE SECURITY CLASSIFICATION

4.2 Chair

The Committee/ Panel will be chaired by the XXXX
The alternate chairperson is XXXXX.

4.3  Secretariat

The NAME Secretariat is to be provided by XXXXX.

The Secretariat will assist the Chair by:

¢ providing notification to attendees of each forthcoming meeting and calling for papers or agenda items
e coordinate or collate agenda papers to be discussed within a meeting

= prepare and circulate the meeting agenda and papers prior to each meeting

e produce minutes and a Record of Actions from meetings

« seek members' endorsement of the minutes as an accurate record

e maintain the register of current and proposed XXXXX

e publish and file endorsed minutes.

4.4 Other Attendees

The Director of Aviation Safety, Deputy Director or Associate Director may attend meetings at their
discretion.

Committee members may request approval from the Chair for other individuals to observe a particular
meeting.

Members of the Committee may also request that individual/s make presentations to the Committee.
Presenters will generally attend the meeting for the duration of their presentation and any subsequent
discussion on the topic only.

With approval from the Chair, a Committee member may invite other persons with relevant knowledge that
may assist the Committee in their deliberation to attend meetings. For example, Subject Matter Expert may
be invited to attend all or part of a NAME meeting to discuss specific issues.

5. Conduct of Meetings
3.1 Frequency

The NAME will meet timeframe or as required by DAS, XXXX or Chair.

5.2 Venue

The meeting time, venue and location is to be determined by the Chair and arranged and communicated by
the Secretariat.

Committee meetings can be held in any convenient location.
Video-conferencing or tele-conferencing is appropriate.

5.3  Scheduled Meetings

The Secretariat will send out a reminder of the upcoming meeting and call for papers timeframe prior to a
scheduled meeting.

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 50f8
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CHOOSE SECURITY CLASSIFICATION

Papers, proposed additional agenda items, and content of presentations are to be submitted to the
Secretariat a minimum of timeframe weeks prior to the meeting date. Material not received two weeks prior
to the meeting will only be included in the agenda, at the discretion of the Chair.

The Secretariat will distribute agenda, papers, the minutes of the previous meeting, and any other required
material a minimum of timeframe week prior to a meeting.

5.4 Unscheduled Meetings

The Secretariat will negotiate the date with the Committee members for any unscheduled meeting as
required.

The Secretariat will formally confirm the agreed date and call for papers and presentations.
A last date for the submission of papers and presentations will be advised in the meeting notification.

2.5 Quorum

A quorum will comprise of the Chair and at least XXXX permanent members.

5.6 Decision Making

Findings and recommendations by the Committee will, wherever possible, be by consensus.

Where consensus between Committee members cannot be achieved, a vote on the matter will be carried on
a simple majority, with all members having equal voting rights.

On request, a dissenting view will be recorded in the minutes.

5.7  Standing Agenda ltems

The Agenda will include the following standing items:
e acceptance of minutes of previous meeting

e actions arising

« status of ongoing projects/XXXX proposals

e new proposals.

6. Tracking and Reporting of Outcomes
6.1 Minutes

The Secretariat will produce and circulate draft Minutes within five business days following a meeting.
Minutes must be accepted at the next Committee meeting as an accurate record before they can be filed or
further circulated.

The Minutes should record:

e date and time of the meeting

 meeting's attendees, apologies and absentees

e brief summary of key discussion points against agenda items
» the action items reflected in the Record of Action

e key agreements, objections or decisions to defer.

Reasons for decisions about proposals will be clearly recorded.

Civil Aviation Safety Authority
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Once endorsed by the members, minutes should be filed in RM8 and made available to interested parties in
accordance with CASA's record management policies and procedures and applicable Commonwealth law.

6.2 Action ltems

The Secretariat will maintain an Action ltems register in the minutes for each meeting. The Action ltems
register will contain details of:

e actions agreed

e name of the individual responsible for undertaking the action
e deliverable or result expected from the action

e due date for the action

e priority (such as how much delay can be tolerated)

e status of action.

Action Items assigned to a member must be accepted by the member and confirmed by the Chair prior to the
conclusion of the meeting. If actions are assigned to members not present at the meeting or other officers,
these will be communicated and agreed by the secretariat immediately after the meeting (within 5 days)

Committee members and other officers responsible for an Action Item will be required to provide the
Secretariat with an update on their action item no later than one week prior to each subsequent Committee
meeting, and will be required to report on the status of the action item during the course of the meeting.

6.3 Projects/ XXXXXX proposal register

The committee Secretariat will maintain a register of active projects/XXXX proposals, including the progress
against project/XXXX proposal milestones specified in the research contract. All XXXXX funding requests for
access to CASA resources or data will be reviewed and cleared by Legal, International and Regulatory
Affairs before contracts are finalised. Approved projects/XXXX proposals are subject to the normal CASA
requirements relating to procurement, contracts, and data release.

After each NAME meeting the Secretariat will provide a report to the XXXX on the status of ongoing
projects/XXXX proposals.

7. Management of projects/XXXXX
proposals

Reporting requirements will vary according to the length of an approved project/’XXXX proposal and the
milestones defined for each project/XXXXX proposal in the associated research contract as applicable.
Milestone reports will be provided to the NAME, and face-to-face briefings of research findings will be
presented at the request of the Chair where relevant.

Under the standard terms of CASA XXXXX funding contracts, CASA will normally retain intellectual property
rights to research funded by CASA.

8. Relationship to Other Committees or
Key Stakeholders

The NAME will provide advice on XXXX-related Funding Proposals to the XXXXX.

The NAME may, through the Chair, communicate with any other CASA committees or business areas on
matters relating to ongoing or proposed projects/XXXXX proposals.

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 7of8
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9. Review

The Chair will, in conjunction with Committee members, review the ToR annually.

Any proposed revisions to the ToR will be considered by the Committee and submitted by the Chair through
the ODAS for DAS approval.

Pip Spencer AM
Chief Executive Officer and Director of Aviation Safety

Civil Aviation Safety Authority
Terms of Reference Template | V1.0 | CASA-01-5550 | Month YYYY 8of8
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CHOOSE SECURITY CLASSIFICATION

CHIEF EXECUTIVE OFFICER and
Civil Aviation Safety Authority DIRECTOR OF AVIATION SAFETY

CASA Ref: [insert PDMS or RMS number]

Prefix FirstName Surname

Number and Street address
SUBURB STATE POSTCODE

CEO-DAS Letter Template

Dear [insert salutation]
| am writing in response to/about. Insert your letter here.

Yours sincerely

Ms Pip Spence PSM
Month YYYY

Civil Aviation Safety Authority
GPO Box 2005 Canberra ACT 2601 | Telephone: (02) 6217 1449 | Facsimile: (02) 6217 1555 1 of1
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Australian Government
Civil Aviation Safety Authority

MINUTE

CASA Ref: RMS Reference

To: Name, Executive Manager, or CEO/DAS
Through: Name, Executive Manager

cc: Name, Job Title

From: Name, Job Title

Subject: Subject to be in bold type

Action Required by: Date due

Recommendations

1. Thatyou approve / endorse / note / sign .... [delete what is not required]
APPROVED / NOT APPROVED / PLEASE DISCUSS
2. Thatyou approve [ endorse / note / sign ....[delete what is not required]

APPROVED / NOT APPROVED / PLEASE DISCUSS

Comments

Pip Spence PSM

Key Points:

1. [insert key information]
2. [insert text]

Key Risks:

3. [insert key information]
4. [insert key information]

Financial impacts:

5. [if there are no financial impacts, this section may be removed. If there are financial/resource
impacts, please show Finance Services has been consulted].

<CLASSIFICATION>



Official

Consultation:

1. [List all bodies not individuals) consulted regarding the information provided in this brief, including
relevant Divisions or other Departments. If there have been differing views these should be detailed.
Note, that LIRA should be consulted on all minutes prior to submission].

Background

2. [Insert key information]

Attachments
3. |If there are no attachments, this section can be removed.
A. [Title of attachment]

B. [Title of attachment] [Delete if not required]

Contact: Name Cleared by:
Position: Title Position:
Phone: Number Phone:
Date: [month year] Date:

Name

Title
Number
[month year]

Page2of 2



Australian Government
Civil Aviation Safety Authority

MEETING BRIEF

CASA Ref: ECO0-000000

To: Pip Spence, CEQ/DAS
Through: EM NOS, EM ROD, EM SED, EM LIRA, EM CSD, CFO (delete who is not required)
cc: Aidan Bruford, Executive Officer to CEO

EM NOS, EM ROD, EM SED, EM LIRA, EM CSD, CFO
(include EMs as CC if not required to clear and provide copies to EMs when sending to CEQ)

Meeting / Event: Meeting or Event

Venue: Microsoft Teams / Boardroom
Timing: Time / Date
Meeting with: [list organisation, names and titles of people attend the meeting]

Internal attendees: EM NOS, EM ROD, EM SED, EM LIRA (delete who is not required)
Prior meetings:  [Delete if N/A]

Outcomes sought:

1. [provide a brief indication if any]

Key issues:

2. [provide a brief indication]

Sensitive and Critical Information:

3. [Include any sensitivities or critical information that will be beneficial for the meeting including a
brief summary of previous engagements with CASA highlighting any active applications or any recent
rejections.] '

Background:

4. [Insert key information]

Attachments:
A. [Brief Bios of key attendees and key facts of organisations, if relevant]
B. [Title of attachment] [Delete if not required]

C. [Title of attachment] [Delete if not required]

Contact: Name Cleared by: Name
Position: Title Position: Title

Phone: Number Phone: Number
Date: [month year] Date: [month year]

<CLASSIFICATION=>



OFFICIAL

Australian Government
Civil Aviation Safety Authority

Board Meeting x-2024
CLICK OR TAP TO ENTER A DATE.

Canberra

‘ Agenda ltem: Insert — refer to the agenda provided for the appropriate number ‘
| Board Action: Decision or Note (choose one) j
| Subject: Insert i
i Origin: Insert (for example: Standing Report or Board Action Item) ;
‘ Prepared by: Responsible Area

Desired Outcome
1. Provide a short sentence on the outcome you are seeking.

2. Number all paragraphs.

Executive Summary
3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

7. Required for Decision Papers only (can be deleted for information papers (Note)).

8. Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
Board Meeting x-2024 | PDMS ECXX | Month YYYY 10f2

OFFICIAL



OFFICIAL

Recommendation:

i 1’:1 is recommended the Board approve (for Decision papers) or note (for Information papers) -
€l
|

e approve additional items
e note additional items
| o additional sub-items

| = delete if not required

Proposed Resolution:

(This box ONLY applies to Decision papers — remove for information papers to Note)

Provide the proposed resolution you anticipate appearing in the minutes of the meeting - i.e. the
proposed resolution should start “The Board approved/agreed/....’

. Prepared by: Name, Position

Consulted with: Name, Position

|  Approved by: Name, Position
Date: Day/Month/Year
Attachments

Attachment A - Insert name here

Attachment B - Insert name here

Civil Aviation Safety Authority
Board Meeting x-2024 | PDMS ECXX | Month YYYY

OFFICIAL

20f2




OFFICIAL

- Australian Government
Civil Aviation Safety Authority

Board Audit and Risk Committee x-2024
CLICK OR TAP TO ENTER A DATE.

Canberra
\
: Agenda Item: 1 — refer to the agenda provided for the appropriate number
| Committee Action: Decision or Note (choose one)
|  Subject: " Insert
| Origin: Standing Report or Action Item (etc.)
Prepared By: Responsible Area

Desired Outcome
1. Provide a short sentence on the outcome you are seeking.

2. Number all paragraphs Please number zall paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.
5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for

further details (as required).
7. Required for Decision Papers only (can be deleted for information papers (Note)).

8. Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
Board Audit and Risk Committee x-2024 | PDMS ECXX | 02/2024
OFFICIAL

10f2



OFFICIAL

Recommendation:
i It is recommended the Committee approve (for Decision papers) or note (for Information papers) ‘
-the....

e approve additional items
e note additional items
o additional sub-item

= delete is not required

|  Prepared by: Name, Position
' Consulted with: Name, Position

‘ Approved: By the Accountable Executive.
| Date: xx Month Year
Attachments

Attachment A - Insert name here

Attachment B - Insert name here

Civil Aviation Safety Authority
Board Audit and Risk Committee x-2024 | PDMS ECXX | 02/2024 20f2
OFFICIAL



OFFICIAL

4 Australian Government
Civil Aviation Safety Authority

Board Strategy Session
CLICK OR TAP TO ENTER A DATE.

Canberra
Agenda Item: Insert — refer to the agenda provided for the appropriate number |
Board Action: Note |
Subject: Insert ‘
Origin: Strategy Papers ‘
Prepared by: Responsible Area 1

Desired Outcome

1. Provide a short sentence on the outcome you are seeking.

2. Number all paragraphs.

Executive Summary
3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

7. Required for Decision Papers only (can be deleted for information papers (Note)).

8. Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
DD Month 202X | PDMS ECXX | Month YYYY 10f2
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 Recommendation:

It is recommended the Board note (for Information papers) - the....

e note additional items
« note additional items

o additional sub items

= delete is not needed

| Prepared by: Name, Position

|  Consulted with: Name, Position

: Approved by: Name, Position
i Date: Day/Month/Year
Attachments

Attachment A — Insert name here

Attachment B — Insert name here

Civil Aviation Safety Authority
DD Month 202X | PDMS ECXX | Month YYYY

OFFICIAL

20f2



OFFICIAL

Australian Government
Civil Aviation Safety Authority

People & Culture Sub Committee 1-2024
CLICK OR TAP TO ENTER A DATE.

Canberra
i
| Agenda ltem: Insert — refer to the agenda provided for the appropriate number .
' Board Action: Decision or Note (choose one)
Subject: Insert :
Origin: Insert (for example: Standing Report or Board Action Item)
| Prepared by: Responsible Area

Desired Outcome
1. Provide a short sentence on the outcome you are seeking.

2. Number all paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk ,

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).
Required for Decision Papers only (can be deleted for information papers (Note)).
Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
People & Culture Sub Committee 1-2024 | PDMS ECXX1.0 | Month YYYY 10of2

OFFICIAL



OFFICIAL

Recommendation:

It is recommended the PCSC approve (for Decision papers) or note (for Information papers) -
the....

\ s approve additional items

e note additional items

o additional sub-item

= delete if not required

Prepared by: Name, Position
Consulted with: Name, Position
L Approved by:  Name, Position
| Date: Day/Month/Year

Attachments

Attachment A — Insert name here

Attachment B — Insert name here

Civil Aviation Safety Authority
People & Culture Sub Committee 1-2024 | PDMS ECXX | Month YYYY 20f2

OFFICIAL



OFFICIAL

‘. Australian Government
¥ Civil Aviation Safety Authority

Executive Committee
CLICK OR TAP TO ENTER A DATE.

Canberra

;‘ Agenda Item: Insert — refer to the agenda provided for the appropriate number |

l‘ EC Action: Decision or Note (choose one) ‘

' Subject: Insert |
Origin: Insert (for example: Standing Report or Board Action Item) '
Prepared by: Responsible Area

Desired Outcome

1. Provide a short sentence on the cutcome you are seeking.
2. Number all paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk
6. Provide high level summary of related risks — provide attachments (include risk assessments) for

further details (as required).

Required for Decision Papers only (can be deleted for information papers (Note)).
Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
Executive Committee | PDMS ECXX-1.0 | 05/2024 10f2

OFFICIAL
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Recommendation:

It is recommended the Committee approve (for Decision papers) or note (for Information papers)
- the.... |

If this paper addresses an action item, include a reference to the relevant action in the open action
register and provide a recommendation to close if the paper completes the action.

If this paper involves costings or financial implications, it MUST be reviewed first by Finance
Branch. It is recommended the EC approve (for Decision papers) or note (for Information papers)
- the....

| e approve additional items
| e note additional items
: o additional sub-item

= delete is not required

Consulted with: Name, Position, Division

Prepared by: Name, Position

Approved by: Name, Position

Date: Day/Month/Year
Attachments

Attachment A — Insert name here

Attachment B — Insert name here

Civil Aviation Safety Authority
Executive Committee | PDMS ECXX-1.0 | 05/2024 20f2
OFFICIAL



OFFICIAL

Executive Committee
CLICK OR TAP TO ENTER A DATE.

Canberra

| Agenda ltem: Insert — refer to the agenda provided for the appropriate number
i EC Action: Decision or Note (choose one)

|  Subject: Insert

|  Origin: Insert (for example: Standing Report or Board Action Item)

: Prepared by: Responsible Area

Desired Outcome
1. Provide a short sentence on the outcome you are seeking.
2. Number all paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number zall paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

7. Required for Decision Papers only (can be deleted for information papers (Note)).

8. Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
Executive Committee | PDMS ECXX-1.0 | 05/2024 10f2
OFFICIAL



OFFICIAL

Recommendation:

It is recommended the Committee approve (for Decision papers) or hote (for Information papers)
[ - the....

If this paper addresses an action item, include a reference to the relevant action in the open action
register and provide a recommendation to close if the paper completes the action.

If this paper involves costings or financial implications, it MUST be reviewed first by Finance

Branch. It is recommended the EC approve (for Decision papers) or note (for Information papers)
-the....

e approve additional items
¢ note additional items
o additional sub-item

= delete is not required

Consulted with: Name, Position, Division

Prepared by: Name, Position
Approved by: Name, Position
| Date: Day/Month/Year
!
Attachments

Attachment A — Insert name here

Attachment B — Insert name here

Civil Aviation Safety Authority
Executive Committee | PDMS ECXX-1.0 | 05/2024 20f2

OFFICIAL
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e Australian Government
Civil Aviation Safety Authority

Aviation Safety Committee No. XX
CLICK OR TAP TO ENTER A DATE.

Canberra

‘ Agenda Item: Insert — refer to the agenda provided for the appropriate number
' ASC Action: Decision or Note (choose one)

! Subject: Insert

! Origin: Insert (for example: Standing Report or Board Action Iltem)

‘ Prepared by: Responsible Area

Desired Outcome
1. Provide a short sentence on the outcome you are seeking.
2. Number all paragraphs.

Executive Summary
3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

Required for Decision Papers only (can be deleted for information papers (Note)).
Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.

Civil Aviation Safety Authority
Aviation Safety Committee No. XX | PDMS ECXX | Month YYYY 10f2

OFFICIAL



IT IS RECOMMENDED THE COMMITTEE APPROVE (FOR DECISION PAPERS) OR NOTE (FOR
INFORMATION PAPERS) - THE....OFFICIAL

Recommendation:
It is recommended the Committee approve (for Decision papers) or note (for Information papers)
- the....

e approve additional items

¢ note additional items
‘ o additional sub-items

1 = delete if not required

Consulted with: Name, Division

Prepared by: Name, Position

Approved by: Name, Position

Date: Day/Month/Year
Attachments

Attachment A — Insert name here

Attachment B — Insert name here
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OFFICIAL

Major Programs Board Meeting No. XX
CLICK OR TAP TO ENTER A DATE.

Canberra
Agenda ltem: Insert — refer to the agenda provided for the appropriate number
; Board Action: Decision or Note (choose one)
| Subject: Insert
|  Origin: Insert (for example: Standing Report or Board Action Item) :
| Prepared by: Responsible Area }
|

Desired Outcome

1. Provide a short sentence on the outcome you are seeking.
2. Number all paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

Required for Decision Papers only (can be deleted for information papers (Note)).
. Refer to How to Consider Risk for Governance Papers for further guidance.
Background
9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.
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Recommendation:

It is recommended the MPB approve (for Decision papers) or note (for Information papers) -
the....

 approve additional items
 note additional items
o additional sub-item

= delete if not required

Project Manager: Name, Position
Senior Responsible Owner: Name, Position

Prepared By: Name, Position

Consulted with: Name, Position

Approved by: Name, Position

Date: Day/Month/Year ,
| |
Attachments

Attachment A — Insert name here

Attachment B — Insert name here
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Major Programs Board Meeting No. XX
CLICK OR TAP TO ENTER A DATE.

Canberra

\

! Agenda Item: Insert — refer to the agenda provided for the appropriate number

; Board Action: Decision or Note (choose one)

. Subject: Insert '
: Origin: Insert (for example: Standing Report or Board Action ltem)

; Prepared by: Responsible Area

L

Desired Outcome

1. Provide a short sentence on the outcome you are seeking.

2. Number all paragraphs.

Executive Summary

3. Keep it high-level and as analytical as possible.
4. Incorporate relevant key issues.

5. Number all paragraphs.

Risk

6. Provide high level summary of related risks — provide attachments (include risk assessments) for
further details (as required).

7. Required for Decision Papers only (can be deleted for information papers (Note)).

8. Refer to How to Consider Risk for Governance Papers for further guidance.

Background

9. Provide the necessary context to explain the subject matter.

10. Include an attachment that provides additional detail — but only if necessary.
11. Number all paragraphs.
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the....
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o additional sub-item

= delete if not required
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| Senior Responsible Owner: Name, Position
|
|
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. !
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Attachment B — Insert name here
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Acknowledgement of Country

The Civil Aviation Safety Authority (CASA) respectfully acknowledges the Traditional Custodians of the lands
on which our offices are located and their continuing connection to land, water and community, and pays
respect to Elders past, present and emerging.

Inside front cover artwork: James Baban.

© Civil Aviation Safety Authority

All material presented in this Guidance document is provided under a Creative Commons Attribution 4.0 International licence, with

the exception of the Commonwealth Coat of Arms (the terms of use for the Coat of Arms are available from the It's an Honour website).
The details of the relevant licence conditions are available on the Creative Commons website, as is the full legal code for the

CC BY 4.0 license.
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Contents
Heading 1 Chapter title

Heading 2
Heading 3

1. Heading 1 Section Numbered

o oo, |

1.1 Heading 2 Numbered
1.1.1 Heading 3 Numbered

Simple text boxes

Appendices

Appendix A — Appendix Numbered is auto-numbered
A1 Appendix Numbered 2 is aute-numbered

~N N | N[O OO;
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Heading 1 Chapter title
Chapter subtitle

To insert a chapter page, insert a Section Break (Next Page) which
will add the chapter page graphics. These graphics will appear in the
headers and footers and look faded on screen — this is how Word

works.
Use a Heading 1 or Heading 1 Numbered for the chapter title.
Use a Page Break to send the text to the next page.




Heading 2

Introduction Paragraph. Use this as the opening paragraph after a Heading 1 or 2.

The Normal style is used for general text content.’
Heading 3
Heading 4

Heading 5
The Normal style is used for general text content.
o Bullet1
— Bullet2
» Bullet3
1. List 1 Legal 1
a. List1 Legal 2
i. List1Legal3
The Normal style is used for general text content.
1. List 2 Numbered 1
T List 2 Numbered 2
1.1.1  List 2 Numbered 3
This text has a hyperlink.

Quote. This text is a quote and uses the style “Quote”. This is already set up with
the correct formatting (as with every style) and is‘accessed from the Styles Pane —
which is separate from the Styles Gallery (found in the Home tab).

' This is a footnote

Civil Aviation Safety Authority
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1. Heading 1 Section Numbered

Normal text.

1.1 Heading 2 Numbered

Normal Text

1.1.1 Heading 3 Numbered
Normal Text

1.1.1.1 Heading 4 Numbered
Normal text

Simple text boxes

The following boxes have the formatting set by the paragraph styles.

Example Box Heading
Example Box Text.

e Example Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should
be simple in purpose.

Note Box Heading
Note Box Text.

¢ Note Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should be
simple in purpose.

Note:  Note Box Text Hanging requires the word “Note:” with a tab at the beginning. The text will
then wrap to the tab point. This is used if a full Note heading is not required.

Warning Box Heading
Warning Box Text.

= Warning Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should
be simple in purpose.
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Appendices

Normal text style is applied after heading styles.

Appendix A — Appendix Numbered is auto-numbered

A1 Appendix Numbered 2 is auto-numbered

Figure 1.  Figure titles go above the figure and are auto-numbered

6
5 I
4 —
3 —
2 —
1 i F———
0 | i

Category 1 Category 2 Category 3 Category 4

mSeries 1 mSeries2 mSeries 3
Table 1. Default Table 1 — Table titles go above the table and are auto-numbered

Column Header ’ Column Header ’ Column Header ‘ Column Header ’ Column Header

Table text Table text Table text Table text Table text
Table text Table text Table text Table text Table text
Table text Table text Table text Table text Table text
Total Row Total Row Total Row Total Row Total Row

Source Notes — The following structure has been created for tables

1. Source Notes Numbered
2. Source Notes Numbered

Table 2. Default Table 2 - This table style uses less space and is generic in colour

Column Header Column Header  Column Header  Column Header Column Header
Table text Table text Table text Table text Table text

Table text Table text Table text Table text Table text

Table text Table text Table text Table text Table text

Total Row Total Row Total Row Total Row Total Row

The above tables do not have the Banded Rows or Banded Columns options turned on.

Civil Aviation Safety Authority
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Table 3.  Default Table 1 - Table titles go above the table and are auto-numbered

Column Header ‘ Column Header Column Header

Table text Table text Table text
Table text Table text Table text
Table text Table text Table text

Table text Table text Table text

The above table has the options “First Column” and “Banded Columns” turned on.

Tables cannot have the column widths defined in the table style. If the column width changes when changing
the text within a table, this is due to Word trying to adjust the table widths as it thinks best fits the content. To
change what is happening, set the correct option by going to Layout > Auto Layout > Fixed width.

The table styles set the text sizes and format the cell colours and lines. It is best to leave the formatting that
is set up, but some adjustment may be done within the confines of the colour themes or bespoke uses. The
example table shown below uses the default Microsoft colours to define the traffic light colours required.

Table 4.  Traffic light colours used in the example of a risk matrix table

Low Medium Low Medium Medium High High

Item 1

Item 2

Item 3

Item 4

Item 5

Source Notes: The Header row above has been manually formatted to remove the shading and lines on cell A1, as well as the shading
on the row to match the first column. ;

Civil Aviation Safety Authority
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This is a caption for the above photo. However, you will still need to insert an Alt-text description. To insert Alt-text, right click the photo
and select "View Alt-text...". Word may try to predict the contents of the photo and insert a generic description, but you will still need to
confirm it and remove the text saying this is an automatically generated description.

Images should be placed in-line with text and go across the full width of the page. Do not use images that
have text wrap around it. This does not conform to accessibility requirements.
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V- Australian Government
Civil Aviation Safety Authority

DOCUMENT TYPE
CASA Report Template - no cover

Subtitle

To edit the version and document numbers in the footer through custom properties:

1. Go to the File tab and click Info
1. Click the Properties subheading dropdown menu and select Advanced properties.
2. Go to the Custom tab, select the appropriate custom field, change the value and click the Modify button.

Document Metadata Properties: Adjust tab as necessary. Property as fields.

Heading 2
Introduction Paragraph. Use this as the opening paragraph after a Heading 1 or 2.

Heading 3
The Normal style is used for general text content.”
e Bullet1
— Bullet2
» Bullet3
1. List 1 Numbered 1
a. List 1 Numbered 2
i. List1 Numbered 3
This text has a hyperlink.

Quote. This text is a quote and uses the style “Quote”. This is already set up with
the correct formatting (as with every style) and is accessed from the Styles Pane —
which is separate from the Styles Gallery (found in the Home tab).

! This is a footnote

Civil Aviation Safety Autherity
CASA Report Template - no cover | V1.0 | CASA-04-6721 | 02/2024 10f5
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Simple text boxes

The following boxes have the formatting set by the paragraph styles.

Example Box Heading
Example Box Text.

» Example Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should
be simple in purpose.

Note Box Heading
Note Box Text.

» Note Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should be
simple in purpose.

Warning Box Heading
Warning Box Text.

e Warning Box Bullet — due to the limitations of Word, only 1 Bullet level is available. Boxes should
be simple in purpose.

Figure 1. Figure titles go above the figure and are auto-numbered

o = N W A~ O

Category 1 Category 2 Category 3 Category 4

mSeries 1 mSeries 2 m=Series 3

Table 1. Default Table 1 - Table titles go above the table and are auto-numbered

Column Header | Column Header ‘ Column Header ' Column Header | Column Header

Table text Table text Table text Table text Table text
Table text Table text Table text Table text Table text
Table text Table text Table text Table text Table text
Total Row Total Row Total Row Total Row Total Row

Civil Aviation Safety Authority
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Source Notes

1. Source Notes Numbered
2. Source Notes Numbered

CHOOSE SECURITY CLASSIFICATION

Table 2. Default Table 2 - This table style uses less space and is generic in colour

Column Header ~ Column Header Column Header  Column Header Column Header
Table text Table text Table text Table text Table text

Table text Table text Table text Table text Table text

Table text Table text Table text Table text Table text

Total Row |Tota| Row | Total Row wi Total Row Total Row

The above tables do not have the Banded Rows or Banded Columns options turned on.

Table 3.

Default Table 1 - Table titles go above the table and are auto-numbered

Column Header Column Header Column Header

Table text
Table text
Table text

Table text

Table text
Table text
Table text

Table text

Table text
Table text
Table text

Table text

The above table has the options “First Column” and “Banded Columns” turned on.

Tables cannot have the column widths defined in the table style. If the column width changes when changing
the text within a table, this is due to Word trying to adjust the table widths as it thinks best fits the content. To
change what is happening, set the correct option by going to Layout > Auto Layout > Fixed width.

Civil Aviation Safety Authority
CASA Report Template - no cover | V1.0 | CASA-04-6721 | 02/2024
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The table styles set the text sizes and format the cell colours and lines. It is best to leave the formatting that
is set up, but some adjustment may be done within the confines of the colour themes or bespoke uses. The
example table shown below uses the default Microsoft colours to define the traffic light colours required.

Table 4.  Traffic light colours used in the example of a risk matrix table

Medium Low ’ Medium Medium High High
4 5
A g ;_ IS
Item 3 6 |

Item 4 4 5 6

Item 5 ) (5}

Source Notes: The Header row above has been manually formatted to remove the shading and lines on cell A1, as well as the shading
on the row to match the first column.

This is a caption for the above photo. However, you will still need to insert an Alt-text description. To insert Alt-text, right click the photo
and select "View Alt-text...". Word may try to predict the contents of the photo and insert a generic description, but you will still need to
confirm it and remove the text saying this is an automatically generated description.

Images should be placed in-line with text and go across the full width of the page. Do not use images that
have text wrap around it. This does not conform to accessibility requirements.
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Acknowledgement of country

The Civil Aviation Safety Authority (CASA) respectfully acknowledges the Traditional Custodians of the lands
on which our offices are located and their continuing connection to land, water and community, and pays
respect to elders past, present and emerging.

Artwork: James Baban.
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How to correctly format names on CASA business
cards

Overview

Our staff business cards list given and surnames only, with certain exceptions. This page
outlines when and how to use these additional titles, honours, academic qualifications,
etc.

Key points

> The pre-nominal (ie before the name) Dr is allowed, where the staff member
» holds a PhD
» is a licensed medical practitioner.
» Post-nominal letters (i.e. after the name) indicating an Australian Honour are allowed,
but only in accordance with the Australian Order of Precedence.
» Staff who display pre or post nominal letters on CASA business cards to which they are

not entitled, may be considered in breach of the Code of Conduct.
Contact

For further information on the use of pre and post nominal letters on business cards

please contact:

Corporate Communications Officer: Natalie Johnson

Natalie. Johnson@casa.gov.au
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